
Apple Users Group
February 29th, 2024 

117th Presentation*

*Since Jan 2010



Next Meeting
March 28th, 2024 
Thursday 1:00pm

2



Apple Event 10/30/23



October Apple Event
•Apple's "Scary Fast" event held on October 30, 2023 was 

unusual in a couple ways


• It was held at 8PM, the first ever night event


• It was very short - only 30 minutes


•Apple announced new 14” & 16”MacBook Pros and a new 24” 
iMac 


• These machines are pretty much identical to previous models 
except they contain a new more powerful chip set - the M3 series
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New MacBook Pros



New MacBook Pros
• The new MacBook Pro models are available with 3 new chips


• The M3, M3 Pro, or M3 Max: Apple’s first 3 nanometer (nm) 
chips


• The base 14-inch MacBook with M3 is up to 60 percent faster 
than the 13-inch MacBook Pro with M1


•Models with the M3 Pro are up to 40 percent faster than the M1 
Pro


• The fastest chip - the M3 Max, supports up to 128GB of unified 
memory and is up to 2.5 times faster than the M1 Max
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New MacBook Pros
• The M3 models will be available in silver and space gray


• The M3 Pro and M3 Max models come in space black or silver


• The 14” MacBook Pro starts at $1,599 (M3), $1,999 (M3 Pro), 
and $3,299 (M3 Max)


• The 16” MacBook Pro starts at $2,499 (M3 Pro), and $3,499 (M3 
Max)


•Apple has discontinued the 13” MacBook Pro
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Apple’s Laptops
MacBook 

Air 13”
MacBook Air 

15”
MacBook Pro 

14” 
MacBook Pro 

14”
MacBook Pro 

16”

Release Date Jul 22 Jun 23 Oct 23 Oct 23 Oct 23

SOC M1/M2 M2 M3 M3Pro/M3Max M3Pro/M3Max

Screen Size 13.3”/13.6” 15.3” 14.2” 14.2” 16.2”
MaxMemory (GB) 16 / 24 24 24 128 128

Max Storage 2TB 2TB 2TB 8TB 8TB
Thunderbolt Ports 2 USB A 2 USB A 2 USB C 3 USB C 3 USB C

Other Ports - - HDMI/SCXC HDMI/SCXC HDMI/SCXC
WiFI/Bluetooth 6/5.0 6/5.3 6E/5.3 6E/5.3 6E/5.3

Battery Life (hrs) 15 15 15 12 15
Starting Cost $999/$1,099 $1,299 $1,599 $1,999/$3,299 $2,499/$3,499



New 24” iMacs



New 24” M3 iMac
•Again, the machine's external design has not really changed from 

the previous models


•You can now get up to 24GB Unified Memory, up from the 
previous model’s 16GB maximum 


• The new iMacs supports Wi-Fi 6E and Bluetooth 5.3 protocol for 
improved connectivity and range 


• The 24” iMac‌ comes in 2 port and 4 port models


• The 2 port model has an 8-core CPU and 8-core GPU, and up to 
1 TB storage and is available in green, pink, blue, and silver
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New 24” M3 iMac
• The 4 port model has an 8-core GPU and 10-core GPU with 2 

additional USB 3 ports, up to 2TB of storage


• The 4 port model comes in 3 additional colors: yellow, orange, 
and purple


•Pricing on the M3 iMac‌ starts at $1,299 for the two Thunderbolt 
port model


• The model with two Thunderbolt ports and two USB 3 ports 
starts at $1,499
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Apple’s Desktops
Mac mini iMac 24” Mac Studio Mac Pro

Release Date Jan 23 Oct 23 Jun 23 Jun 23
SOC M2/M2 Pro M3 M2 Max/M2 Ultra M2 Max/M2 Ultra

Max Memory (GB) 24/32 24 192 192
Max Storage (TB) 2/8 2 8 8

Ethernet (GB) 1,10 1,10 10 10 (Dual)
USB-A Ports 2 0 2 3
USB-C Ports - 0 or 2 0/2 0

Thunderbolt Ports 2/4 2 4/6 8
WiFI/Bluetooth 6E/5.3 6E/5.3 6E/5.3 6E/5.3
Starting Cost $599/$1,399 $1,299 $1,999/$3,999 $6,999



Upgrade Advise
• If you’re happy with your current setup, don’t upgrade, but if you do decide to 

upgrade: 

1. Pick the type of Mac you want (iMac, MacBook, Mac mini)

2. Pick out how much storage & memory you need and the features you want (ex. 
# and type of ports, # of displays, etc…) 


3. Get the cheapest chip that meets all your other criteria


• I think any M-Series chip would be more than suitable for anyone who uses 
typical consumer software (email, browser, office products, iMovie, Photos, etc…)


• The only people in my opinion who benefit from the higher level chips are high 
end gamers, videographers, professional photographers, music producers, 
software coders, etc…
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Vision Pro



Vision Pro
•Apple announced the Vision Pro at WWDC23 (see my August ‘23 

presentation for details)


• This is a completely new product category that Apple refers to 
as “Spatial Computing”


•Apple released the Vision Pro for sale this month


•You can now get a personalized demo at an Apple Store, just 
signup for it on Apple’s website
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Vision Pro Costs
•Base Unit:


• $3,499 for 256GB


• $3,699 for 512GB


• $3,899 for 1TB


•Optical Inserts:


•Reader - $99


•Prescription - $149


•Apple Care:  $500
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My Take
• From what I’ve seen so far, Spacial computing just looks like  

spectacular


• The hardware appears to be very high quality


• I think watching Movies on these will be a fantastic experience 
(especially 3d movies)


•While, I’m not a gamer, I suspect Gaming will also be amazing


• I think it’s only the beginning and will get much better with time


•Will I buy one now?
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Why Not?
• It’s very expensive:  $3,499 to $4,548


• It’s a bit too bleeding edge for me - not only is it a new product, 
but a new product category with all new software - I want the dust 
to settle before I even think about it


•As fantastic as it appears, I’m not sure I want to wear a headset 
for any extended period of time


•While watching movies is very appealing, I don’t ever watch 
movies by myself


• I very much want to demo it at some point
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USB-C Apple Pencil



Apple Pencil USB-C
•Apple is now selling a new Apple Pencil compatible with any 

iPad equipped with a USB-C port


• It doesn’t replace anything, the original Apple Pencil and the 
2nd generation Apple Pencil are still being sold 


• It has a similar design as the Apple Pencil 2, but with a USB-
C port hidden under a sliding cap for charging and pairing 
over a USB-C cable


• It does attach magnetically to compatible iPads, including 
the tenth-generation iPad, but it does not support wireless 
charging or wireless pairing
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Apple Pencil USB-C
•Also, unlike the Apple Pencil 2, the new model lacks 

pressure sensitivity on an iPad screen or the double-tap 
gesture for switching between drawing tools


• It does supports the Apple Pencil “Hover” feature when used 
with an iPad Pro model released after October 2022


• It weighs roughly the same as the Apple Pencil 2, but it is 
around 7% shorter


• It costs $79 which is cheaper than the first two generations 
of the Apple Pencil ($99 and $129)
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My Take
•Before you buy anything, check compatibility to make sure it 

works with your iPad


• The Apple Pencil 2 is the premier device with the most 
features, and serious artists might appreciate these features


• I like the USB-C model’s charging method best of the 3 models


• I’d probably prefer the USB-C model for me if I was in the 
market


•Or probably even a better option - Look at 3rd party offerings, 
which tend to have most of the features at a fraction of the cost
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Stolen Device Protection



Stolen Device Protection
• There have been a lot of stories in the news about a scheme 

where a thief observes someone entering their passcode on an 
iPhone


•Once they have the passcode, they steal the actual phone, and 
proceed to change the user’s credentials, locking the original 
user out of the device, while they proceed to use the phone to 
rob them


• Law enforcement has stated that this particular crime tends to 
target older people more and more
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Stolen Device Protection
•Apple has addressed this by adding a new feature “Stolen Device Protection” 

with iOS 17.3


•Stolen Device Protection must be turned on before the device is lost or stolen


•When Stolen Device Protection is enabled, some key features and actions will 
require biometric authentication (either Face ID or Touch ID)


• This prevents someone who has stolen your device and knows your 
passcode from making critical changes to your account or device 


•Also certain security actions such as changing your Apple ID password will 
require you to wait an hour and then perform a 2nd Face ID or Touch ID 
authentication 
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Stolen Device Protection
• This security delay is designed to prevent a thief from performing 

critical operations before you have a chance to mark your device 
as lost 


•When your iPhone is in a familiar location (generally home or 
work), these additional steps are not required


•With Stolen Device Protection turned on, and your iPhone is not 
in a familiar location, it forces you to authenticate with Face ID or 
Touch ID before you can take certain actions (see next page)
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Stolen Device Protection
•Use passwords or passkeys saved in Keychain


•Use payment methods saved in Safari (autofill)


• Turn off Lost Mode


•Erase all content and settings 


•Apply for a new Apple Card, or view the Apple Card virtual card 
number


• Take certain Apple Cash and Savings actions in Wallet (for example, 
Apple Cash or Savings transfers)


•Use your iPhone to set up a new device (for example, Quick Start)
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Stolen Device Protection
•You turn on Stolen Device Protection in Settings → 

“FaceID & Passcode”


• The following are requirements for Stolen Device Protection:


• Two-factor authentication for your Apple ID


• The phone must have a passcode, and either Face ID or Touch 
ID 


• “Find My” and “Significant Locations” (in Location 
Services) must be enabled
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•You should turn this on ASAP (I see 
very little down side)


• Turn off Stolen Device Protection 
before you sell, give away, or trade in 
your iPhone
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tvOS 17.2
• The tvOS 17.2 update makes it easier to navigate and find content in 

the TV+ app


• These changes have taken place on the TV, as well as the most TV+ 
apps on iPhone, iPad, or smart TVs 


• iOS 17.2 adds a dedicated sidebar that contains content from different 
apps and streaming services, including TV+


•Note: The iPhone “sidebar” is located at the bottom of the screen


• The sidebar has dedicated sections for Search, Home, TV+‌, MLS 
Season Pass, Sports, the Store, and the Library


• Tapping on the TV+ section will show only TV+ content
40
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tvOS 17.2
• In a separate "Channels and Apps" area, users can access content 

from other streaming services that integrate with the TV app


• Included streaming services include ABC, CBS, Comedy Central, 
Disney+, ESPN, Discovery, Max, Prime Video, and more 


• Tapping on a channel like Disney+ shows content and watch 
suggestions just for that service


• This helps in searching for content regardless of where it’s located


• If you then tap on Disney+ content, it will take you to the Disney+ 
app to play the content
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Let’s talk about Apps



iOS Journal App
•Apple released a new iPhone app called “Journal” that, as you 

might suspect, facilitates keeping a personal journal or diary


• It uses on-device machine learning to display personalized 
suggestions for a journal entry 


•Suggestions are curated from recent activities, including photos, 
people, places, workouts, and more


• I’ve tried it and it seems simple and straightforward, but I don’t 
keep a diary, so I’m probably not the target audience for this


•But, if you would like this functionality, give it a try!
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Apple Sport App
•Apple also recently introduced “Apple Sports”, a free iOS app which 

also runs on the iPad


•Apple Sports is personalized with your favorite leagues, tournaments, 
and teams and displays an easy-to-read scoreboard


•You can navigate between scores and upcoming games, see play-by-
play information, team statistics, lineup details, and live betting odds 
(betting odds can be turned off in settings)


• It includes links to Apple News, the Apple TV app, and other connected 
streaming services 


• The app is "designed for speed and simplicity," according to Apple
49
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Apple Sports App



NYT Game App
• I recently discovered this new favorite app 


• It’s available on iPad and iPhone and is free (with in-app purchases) 


• It has many popular apps available on the NY Times web site: Wordle, 
Connections, Sudoku, Mini Crossword puzzle, and much more …


•Many games are free for the current day, and you can subscribe for 
$5.99/month to unlock additional days/games


• The games I especially like are Connections, Sudoku, and the Mini 
Crossword all of which are free for the current day


• Try it, you might like it!
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Connections Solution52



Sudoku Mini Crossword53



Mac Weather app
•macOS 14.2 added new features to the Weather app: Many features 

also available on iPhone and iPad weather apps


• The app can display precipitation amounts over the next ten days 


•New widgets for: next-hour precipitation, daily forecast, sunrise and 
sunset times, and current conditions such as Air Quality, Feels Like, 
and wind speed


• The wind map snapshot helps you quickly see wind patterns and an 
animated wind map overlay for the next 24 hours


•An interactive moon calendar lets you visualize the phase of the moon 
on any day for the next month
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Quick Tips



QR Codes in iOS 
• If you see a QR code in the wild, you can open the Camera app, 

aim, and tap the link that gets revealed (or alternatively use the 
code scanner in the control center) 


•But what about QR codes in images and PDFs that are already 
on your iPhone?


• If you tap and hold on the QR code, a menu is revealed with the 
URL 


•You then can: open the link in Safari, copy the link, or share it 
with someone else
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FaceTime Gestures
•You can now make gestures that will produce reactions on FaceTime or Zoom 

screens


•Heart shape using both hands - Hearts


•Single thumb up - Thumbs up emoji


• Two thumbs up - Fireworks


•Single thumb down - Thumbs down emoji


• Two thumbs down - Rainy storm


•Victory/peace sign with one hand - Balloons


•Victory/peace sign with two hands - Confetti


• "Rock on" sign (🤘) on both hands - Lasers
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FaceTime Gestures
•Supported devices:


•Apple Phone 12 and later


• iPad Pro 12.9-inch (3rd generation and later)


• iPad Pro 11-inch (1st generation and later)


• iPad (8th generation and later)


• iPad Air (3rd generation and later)


• iPad mini (5th generation and later)


•Apple TV 4K (2nd generation and later)


•Mac with Apple silicon running macOS Sonoma
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Find your Watch
• For some time now, you’ve been able to use your Watch to 

find your iPhone


•You just go to Control Center on your Watch and hit the 
appropriate icon, and you iPhone will make a sound to help 
you find it


• I use this all the time, and now with iOS 17, you can do the 
reverse


• Just go to Control Center on your iPhone and hit an icon to 
make a sound on your Watch
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Mac Battery Widget
• The only disadvantage of using wireless input devices such as a 

keyboard, trackpad, or mouse is that you need to recharge them 
occasionally 


• I have historically checked my battery status using the bluetooth 
option in the Menu Bar


•Recently, I’ve noticed that this menu was not showing the 
charging status of some devices


• There is a Mac widget that shows the same information but 
better in my opinion and it does show charging status correctly
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macOS Battery Widget

Menu Bar - BlueTooth( )



New Watch app list
• If you press the digital crown on the Watch you’ll get a view of 

all your apps in one of two styles:


• The List view will list all your apps in alphabetical order and you 
can scroll to the app you desire


• The Grid view has the app icons in a honeycomb type grid


• The old Grid moved left, right, up, and down and just seemed 
very awkward to me


•Because of this, I’ve always used the List view
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New Watch app list
•However, with watchOS 10, the grid view has improved


•You still get the same honeycomb layout, but now the app icons 
are contained with the sides and you only scroll up or down


•You also can easily order your favorite apps at the top, so it is 
very easy to see and launch the apps you use most


• It’s a great change, and something you might want to try if you 
(like me) switched to List view long ago
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New Grid ViewList View



Digital Crown
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•Press once to see grid view

•Scroll to see additional apps

•Press twice to see most 
recent apps

•Use Watch app on iPhone to 
rearrange order

•Scroll to bottom to change 
to list view
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Changing Watch Faces
•With watchOS 10.0, Apple removed the ability to change watch 

faces by simply swiping left or right


•A lot of people objected to this, so in watchOS 10.2, Apple 
provided a way to re-instate the previous behavior


•On the Watch, go to Settings → Clock, then toggle on “Swipe 
to change watch face” to have it work like it did in the past


•Note:  This is not the default and you have to make the above 
change to re-enable it
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On Watch: Settings → Clock
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Resizing Mac Windows



Resizing Mac Windows
• To Move a Window:


•Put your cursor on an empty space at the top of the window (Title 
bar), and drag the window wherever  you wish


• Full Screen Mode:


•Makes a window full screen and occupies an entire Space in 
mission control


• To enter Full Screen go to the Menu Bar: View→Enter Full Screen


•Or… Click green traffic light button at left top of window:  
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Resizing Mac Windows
• Tile to left or right of screen:


•Will take a window and fill either the left or right side of screen in 
full screen mode


• The next window you select will then fill the opposite side of the 
screen in full screen mode


•Menu Bar: Window→Tile Window to Left (or Right) Side of 
Screen


•Hover over green traffic light button and select the appropriate 
Tile command:  
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Resizing Mac Windows
•Move to Left or Right Side of screen:


•Will resize the window to fill half of the screen on either the right or 
left side


• “Move to” will not go into full screen mode unlike the Tile command


•You can then arrange whatever window(s) you like in the other half of 
the screen


• To do this, hold down option key and then:


•Menu Bar: Window→Move Window to Left (or Right) Side of Screen


•Hover over green traffic light button and select the appropriate 
Move command:  
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Resizing Mac Windows
•Zoom


•Expands Window to fit content on screen


• I find this command to be fairly unpredictable depending on the 
window and content


• To do this in the Menu Bar select Window→Zoom


•Or… Hold the Option key and click green traffic light button:  
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•Using a TrackPad or Mouse:


• If you move the cursor to the edge of a window, the cursor will 
change from a ( ) symbol to a (↔︎) symbol


• Likewise if you move the cursor to the corner of a window, the 
cursor will change from a ( ) symbol to a ( ) symbol


• This tells you, you can move that side or corner of the window by 
dragging with your trackpad or mouse


•You can modify this behavior with modifier keys or by double-
clicking per the following table
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Action Cursor At Any Side (top, bottom, left, right) Cursor At Any Corner

Drag Moves that side Moves both adjacent sides

Option Drag Moves side and opposite side, keeping window location centered Moves both opposite corners keeping window location centered

Shift Drag Moves the edge and adjacent sides keeping the same height/width ratio Moves Corner keeping same height/width ratio

Option Shift Drag Resizes from center keeping same height/width ration Same: Resizes from center keeping same height/width ration

Double Click Moves side to edge of screen Moves that corner to edge of screen

Option Double Click Moves side and opposite side to edge of screen Expands all 4 sides to fill entire screen

Resizing Mac Windows

Use this table and experiment
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Problems

• I’m going to review a few problems that I ran across 
over the last few months with solutions


• They were all a bit “weird”, and certainly not your run of 
the mill issues


• I’ve included them  here in case you are currently 
experiencing them or run into them sometime in the 
future
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FaceBook Noise



Facebook Noise
•All of a sudden, when looking at Facebook on my iOS devices, I 

started hearing little “drip/squeaky” noises


• I have no idea why Facebook did this


• The good news is you can turn this behavior off in Facebook 
settings


•Go to “Facebook → Settings → Media” and turn off “In-App 
Sound”


• I also turned off “Videos Start with Sound” And “Stories Start with 
Sound”, but I’m not sure what they do?
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FaceTime Issue



FaceTime Screen Sharing
•Screen sharing in FaceTime is a great way to share content 

(Photos, movies, etc…), and is also a great tool when 
troubleshooting a problem with someone remotely


•Recently, when trying to help a friend on their Mac, screen 
sharing no longer worked


• It never gave an error message - after hitting the correct buttons, 
it just didn’t do anything


•After troubleshooting, we found that screen sharing was turned 
off in settings - No idea how this happened???
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MacMail/Gmail



Gmail Password
•A friend changed their Google (Gmail) password on the Google 

website


• Then when going into Apple Mail for the first time, as expected, 
they were asked to sign in with the new password and were 
given a link to open a special sign-in web page 


•After following the directions, Google put up a screen with the 
choice to cancel or continue to sign in to MacOS 


•After choosing to sign in to MacOS, I see the most annoying 
error message I’ve ever seen 
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Everything fine up to this point



World’s Worse Error Message
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Error Message
•After a frantic search to try to determine how to fix this issue, I 

finally found the following solution


• In Safari Settings, under the Privacy tab uncheck "Hide IP 
Address", and under the Advanced Settings uncheck "Use 
advanced Tracking & Finger Print Protection" 


•Once that was unchecked everything worked as expected


• I’ve seen this setting cause other problems in the past and I’d 
recommend changing it (I suspect Apple is trying to hide 
something that Google required to proceed)

95



96

Safari Settings on Mac
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Siri Remote Issue



Volume Buttons TV 
• I’ve had this problem now a couple of times on my TV Siri 

remote, and it’s very frustrating


•When I used the Siri Remote to raise or lower the volume on the 
TV, the volume would go all the way up to the max or all the way 
down to the minimum


•You can not set the volume anywhere in between


• The only way I’ve found to fix this is to reset the Siri Remote


•Here’s how to reset the Siri Remote:
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Volume Buttons TV 
•Press and hold the TV/Control Center button and 

the Volume Down button at the same time and hold 
the buttons down for about 5 seconds


•Release the buttons, and wait 10-15 seconds for a 
Remote Disconnected notification to appear on 
your TV screen


•Press any button on your remote, and when the 
Remote Connected notification appears, you can 
use your remote
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Questions?
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